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1. Introduction to Kernel for SQL Database 

Welcome to the user manual for Kernel for SQL Database, an effective and powerful data recovery 
software to recover data from the corrupt SQL databases (.mdf). This user manual comprises step by step 
guidelines on using Kernel for SQL Database. 

1.1  Using this Manual 

This user manual is intended to guide users on using Kernel for SQL Database. We suggest that first time 
users should read this user manual completely and carefully before proceeding to use the software. 
However, if you are an experienced user, you can use the table of contents to find out information 
pertaining to the tasks that you need to perform by using Kernel for SQL Database.  

You can use the table of contents to navigate through different sections of this user manual. The table of 
contents lists all the sections that are contained in this user manual in chronological order. This user 
manual comprises following sections: 

 Introduction 

 Getting Started 

 Software Interface 

 Repairing .mdf Files 

 Full Version 

 Support 

 Troubleshooting 

 Legal Notice 

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of 
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual. 

1.1.1 List of Abbreviations 

MS: Microsoft 

SQL: Structured Query Language 

QFSCI: Quick File System Component Identification 

RAM: Random Access Memory 

MB: Mega-Byte 
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GB: Giga-Byte 

1.2 About Kernel for SQL Database 

Kernel for SQL Database is database recovery software that recovers data from corrupt, damaged .mdf 
database files. Kernel for SQL Database software is equipped with powerful QFSCI algorithm which 
efficiently scans and retrieves data from the corrupt databases. 

The common reasons which lead to SQL database corruptions are: 

 Invalid database file header 

 Not able to associate database file with different databases 

 Internal Program Error(s) 

 Crash or failure of hard drive 

 Media contamination or damage 

 Accidental deletion of data and files 

 Accidental deletion of data and files 

 Accidental reformatting of partitions 

 Virus attacks  

 Data corruptions 

1.3 Salient Features 

Salient features of Kernel for SQL Database include: 

 Supports recovery of data from SQL Server version 2000, 2005 and 2008. 

 Effectively repairs and extracts data from the corrupt SQL database (.mdf). 

 Creates script file(s) where the recovered files are saved. 

 Deleted records can be recovered and are saved in a separate SQL script. 

 Recovery of Microsoft SQL server backup files. 

 Recovery of tables, triggers, views, and stored procedures. 

 Recovery of primary keys, indexes, unique keys and foreign keys. 

 Recovery of predefined defaults, default values, rules, checks, and user data types (default, rule, Allow 
null). 
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 Efficiently repairs large databases 

1.4 Who Should Use this Software? 

The capability of Kernel for SQL Database to repair large SQL databases makes it appropriate for use by 
SQL server administrators, who need to recover data from corrupt or damaged .mdf database files. The 
corruption could have been caused due to virus attacks, improper system shutdown, network problems, 
database file header corruption etc. 
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2. Getting Started 

Now that you have understood the features and potential of Kernel for SQL Database, you are ready to 
get a hand on experience of the software. To start repairing .mdf files, you will first need to download and 
install this software.  

It is strongly recommended that before installing Kernel for SQL Database, you should go through the 
installation pre-requisites for the software to ensure that your computer is appropriately configured to run 
the software. 

2.1 Installation Pre-requisites 

The various pre-requisites for installing and running Kernel for SQL Database can be broadly classified 
into two major categories – Hardware requirements and Software requirements. 

2.1.1 Hardware Requirements: 

The hardware requirements for installing the software are as follows: 

 Pentium class processor 

 Minimum 64MB RAM (128 MB recommended) 

 10MB for Software installation 

 Disk Space - Enough space to store the repaired files 

 You should have at-least 40 MB of free disk space if you want to repair and save a 
40 MB.mdf file. 

2.1.2 Software Requirements: 

The software requirements for installing the software can further be grouped into two categories– 
Operating system requirements and SQL Server version requirements. The requirements are as follows: 

2.1.2.1 Operating System Requirements 

Supported operating systems: 

 Windows Vista 

 Windows XP 

 Windows 2003 

 Windows 2000 
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2.1.2.2 SQL Server Version Requirements 

Supported SQL Server versions: 

 SQL Server 2000 

 SQL Server 2005 

 SQL Server 2008  

2.2 Downloading Kernel for SQL Database for the First Time 

After checking your computer with the prescribed system requirements for Kernel for SQL Database, you 
can download and install the software on your computer. You can buy the full version of the software from 
any one of our authorized resellers– Element5, Asknet and 2CO. 

If you want to try using Kernel for SQL Database before buying it, you can download the evaluation 
version from the following link: 

http://www.nucleustechnologies.com/download-sql-recovery.php 

 You can repair .mdf files saved on your system by using the evaluation version of 
Kernel for SQL Database; however, the repaired file will not be saved until you 
purchase the full version of the software. 

2.3 Install Kernel for SQL Database 

After downloading the installer file for Kernel for SQL Database, you can install the software by running the 
file. To install Kernel for SQL Database: 

1. Double-click the Kernel for SQL Database installer. 

2. Follow the on-screen instructions.  

The Setup Installation Complete screen will be displayed. 

3. Click Finish to launch the software.  

2.4 Start Kernel for SQL Database 

To start Kernel for SQL Database: 

Click the Start  All Programs Kernel for SQL Database 

Alternatively, you can launch Kernel for SQL Database by double-clicking the shortcut icon available on 
the desktop and Quick Launch icon. 

2.5 Uninstall Kernel for SQL Database 

http://www.nucleustechnologies.com/download-sql-recovery.php
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You may need to uninstall and re-install Kernel for SQL Database. To uninstall Kernel for SQL Database: 

1. Click the Start  All Programs Kernel for SQL Database  Uninstall Kernel for SQL Database 

A warning message will be displayed. 

2. Click ‘Yes’ to uninstall Kernel for SQL Database. 

 Before proceeding to uninstall Kernel for SQL Database, you must ensure that the 
software is not running. 

You can alternatively uninstall Kernel for SQL Database from the Control Panel by performing the 

following steps: 

1. Click the Start Menu  Control Panel and then double click the Add or Remove Programs icon. 

2.  Select Kernel for SQL Database and click Remove. 

A warning message will be displayed. 

3. Click Yes to uninstall Kernel for SQL Database. 
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3. Software Interface 

Now that Kernel for SQL Database has been installed on your computer, you can start using the software 
after getting acquainted with the software interface. 

3.1 Menu-bar 

The menu-bar of Kernel for SQL Database comprises four main menus– File, Tools, View, and Help. 

3.1.1 File Menu 

The File menu comprises five menu items. 

 

Figure 3.1: File Menu 

Menu items in the File menu: 

Field Name Field Description 

Open Select to browse and list corrupt .mdf file from your disk 

Save Select to save the recovered results from .mdf file 

Exit Select to close the software 

3.1.2 Tools Menu 

The Tools menu comprises one menu item. 

 

Figure 3.2: Tools Menu 

Menu Items in the Tools menu: 

Field Name Field Description 
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Options Select this option if you want to scan the entire 
database for possible corruption. This option is 
recommended to be selected while performing 
SQL database repair. 

3.1.3 Help Menu 

The Help menu comprises three menu items. 

 

Figure 3.3: Help Menu 

Menu items in the Help menu: 

Field Name Field Description 

Kernel for SQL Database Help Select to view user's help guide of Kernel for 
SQL 

Kernel for SQL Database Homepage Select to view software website 

About Kernel for SQL database  Select to view version information of the 
software 

3.2 Tool-bar 

The tool-bar in Kernel for SQL Database is displayed below the menu-bar. The tool-bar provides a 
convenient and user-friendly method to perform certain actions that can also be performed by using the 
menu-bar. Read the information in the table below to find out about the tool-bar buttons: 

Button Button Name Button Description 

 

Select Click to select corrupt .mdf file from your disk 
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Save Click to save the recovered results on your disk 

 

Help Click to view Kernel user's guide 

3.3 Buttons Used 

Apart from the standard options available in the menu-bar and the tool-bar, following are the buttons which 
are displayed on the main window. 

 
This option initiates the recovery process of the selected database 

 
This option cancels the action and closes the dialog 

 
This option lets you locate the affected SQL database 

 This option takes you to the previous page in the record 

 This option takes you to the next page in the record 

 
This option lets you stop the ongoing process 

 This option allows you to refresh the process 
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4. Repairing .mdf Files 

Now that you have complete familiarity of the user interface of Kernel for SQL Database, you are ready to 
repair .mdf files. To repair .mdf files: 

1. Launch Kernel for SQL Database. 

 

Figure 3.4: Software Welcome Page 

 

 "Select SQL Database" dialog appears by-default when the software is launched. 
This dialog can be launched by clicking the Open button in Tool bar or by selecting 

File menu > Open.  

 

2. Click the Browse button to locate the corrupt SQL Database: 
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Figure 3.5: Select Database to Recover 

 

3. Select the SQL Database version with which the MDF file is created: 
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Figure 3.6: Select SQL Server Version 

 

4. Click the Recover button to start the recovery process. 

After repairing the corrupt .mdf file, Kernel for SQL Database will enlist the SQL database objects in the 
left pane: 
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Figure 3.7: Recovered Objects 

 

Note that, if the user selects the wrong SQL Server version, software displays the following error: 

 

5. Select an object in the left tree whose content you want to verify before saving. When you select the 
folder, its content will be displayed in the right pane: 



© L e p i d e  S o f t w a r e  P r i v a t e  L i m i t e d                       

 

Figure 3.8: Preview of Recovered Objects 

 

6. After previewing the required items, select the data for saving and then click the Save button. The 
'Saving Mode' dialog box appears: Click the Save button to start the process of saving. 
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Figure 3.9: Saving Options  

 

 To save the data you can click the Save button on the Tool bar or go to File menu > 

Save  

 

You can save the recovered objects in two different modes which are: 

SQL Server: Using this option, the recovered objects can be saved on SQL Server directly, even if the 

Server is running. To save the data on SQL Server: 

 Mention Server Name and Name of the database in Server Name and Database name fields 
respectively. Do not provide name of existing database in Database name field. Create a new 
database in SQL Server Management Studio and enter the name of new database in Database 
name field. However, existing database name can also be provided but in case of existing 
database restored objects will get merged with existing objects.  

 Select the Authentication option with which you wish to access the SQL Server i.e. Windows 
Authentication or Server Authentication  
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To access SQL Server with Server Authentication, you need to enter User Name and Password in the 
respective fields.  

Batch File: Using this option, you can save the batch file of the rebuilt SQL database on a desired 
location. To save the recovered, you need to browse the location using the Browse button. The data so 

recovered is saved in separate script files at the desired location. Also, a script file (commit.bat) is also 
created that enables the user to easily copy the recovered objects to a new database created on SQL 
Server. To copy recovered objects to new database on SQL server: 

 Go to SQL Server Management Studio  

 Create a New Database  

 Double click on commit.bat  

OR 

 (Run->cmd ) Change the path to recovered folder ( cd PathName) 

 Use following syntax:  

>commit.bat servername newcreateddatabase sqlserverusername sqlserverpassword  

 

Press Enter key and all tables will be copied to the new created database.  

7. After selecting the required Saving mode option, click the OK button. The software starts saving the 

recovered objects: 
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Figure 3.10: Saving Process 

 

8. The software displays following 'Process Completed' dialog box when the data is saved successfully at 
the desired location: 
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Figure 3.11: Saving Process Completed 

 

9. Click the OK button to close the 'Process Completed' dialog box.  
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10. Full Version 

Although you can use Kernel for SQL Database evaluation version for free and experience the capabilities 
of the software, there are certain features that are not available in the evaluation version. 

10.1 Requirement of Full Version 

By using the evaluation version of Kernel for SQL Database, you can repair corrupt .mdf files; however, 
you cannot save the recovered data. 

You will need to buy the full version of the software to save the recovered .mdf files. 

10.2 Purchasing Full Version 

You can buy the full version of Kernel for SQL Database from any one of our authorized resellers – 
Element5, Asknet and 2CO. 

As soon the purchase transaction with our resellers gets completed, our sales team will send you an email 
comprising the URL to download the full version of Kernel for SQL Database and activation details of the 
software. 
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11. Support 

We have an extensive and efficient support system in place to assist our customers with all issues related 
to using Kernel for SQL Database. The software comes with an embedded help manual that can be 
accessed by clicking Help Help in the menu-bar. You can also press the F1 key on the keyboard of your 

computer to access the embedded help of Kernel for SQL Database. 

You can access the online help for Kernel for SQL Database at 
http://www.nucleustechnologies.com/Online-Helps.html 

We also have live support wherein you can chat with our software experts at 
http://www.nucleustechnologies.com/Support.html . To talk on phone with our software experts call: 

Help line:  

 

+91-9818725861 

1-866-348-7872 (Toll Free for US/CANADA) 

You can also email us about your queries at; 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 

  

http://www.nucleustechnologies.com/Online-Helps.html
http://www.nucleustechnologies.com/Support.html
mailto:sales@nucleustechnologies.com
mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com
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12. Troubleshooting 

This section deals with your generic and specific queries pertaining to using Kernel for SQL Database. 

12.1 Common Issues 

Why does Kernel for SQL Database have limitations in evaluation copy? 

The free evaluation version of Kernel for SQL Database is intended to enable you to experience the 
capabilities of the software. You will need to buy the software to save the recovered results. 

12.2 Frequently Asked Questions 

How to Buy Kernel for SQL Database? 

You can buy Kernel for SQL Database online at http://www.nucleustechnologies.com/buy-sql-
recovery.php  

I have lost my full version for Kernel for SQL Database. Can you help me? 

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address, 
and order confirmation number (if you have it). We will be happy to help you. 

  

http://www.nucleustechnologies.com/buy-sql-recovery.php
http://www.nucleustechnologies.com/buy-sql-recovery.php
mailto:sales@nucleustechnologies.com
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13. Legal Notices 

This section comprises the legal specification about Kernel for SQL Database and the company LEPIDE 
SOFTWARE PRIVATE LIMITED 

13.1 Copyright 

LEPIDE SOFTWARE PRIVATE LIMITED, Kernel accompanied user manual and documentation are 
copyright of LEPIDE SOFTWARE PRIVATE LIMITED, with all rights reserved. Under the copyright laws, 
this user manual cannot be reproduced in any form without the prior written permission of LEPIDE 
SOFTWARE PRIVATE LIMITED. No Patent Liability is assumed, however, with respect to the use of the 
information contained herein. 

© LEPIDE SOFTWARE PRIVATE LIMITED. All rights reserved. 

13.2 Trademark 

Kernel TM is a copyright work LEPIDE SOFTWRE PRIVATE LIMITED. 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 
Advanced Server®, Windows 2003 Server®, Windows XP®, SQL Server and MS-DOS are registered 
trademarks of Microsoft Corporation. 

All other brand and product names are trademarks or registered trademarks of their respective companies. 

13.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. LEPIDE SOFTWARE PRIVATE LIMITED provides no warranty with regard to 
this manual or any other information contained herein and here by expressly disclaims any implied 
warranties of merchantability or fitness for any particular purpose with regard to any of the foregoing 
LEPIDE SOFTWARE PRIVATE LIMITED assumes no liability for any damages incurred directly or 
indirectly from any technical or typographical errors or omissions contained herein or for discrepancies 
between the product and the manual. In no event shall LEPIDE SOFTWARE PRIVATE LIMITED, be liable 
for any incidental, consequential special, or exemplary damages, whether based on tort, contract or 
otherwise, arising out of or in connection with this manual or any other information contained herein or the 
use there of. 

13.4 License Agreement 

Kernel for SQL Database Copyright © by LEPIDE SOFTWARE PRIVATE LIMITED 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 
software, unless you have a different license agreement signed by LEPIDE SOFTWARE PRIVATE 
LIMITED. The terms and conditions of this License describe the permitted use and users of each Licensed 
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Copy of Kernel for SQL Database. For purposes of this License, if you have a valid license, you have the 
right to use a single Licensed Copy of Kernel for SQL Database. 

Scope of License 

Each Licensed Copy of Kernel for SQL Database may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. All 
rights of any kind in Kernel for SQL Database, which are not expressly granted in this License, are entirely 
and exclusively reserved to and by LEPIDE SOFTWARE PRIVATE LIMITED. You may not rent, lease, 
modify, translate, reverse engineer, decompile, disassemble, or create derivative works based on,  Kernel, 
nor permit anyone else to do so. You may not make access to Kernel for SQL Database available to 
others in connection with a service bureau, application service provider, or similar business, nor permit 
anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Kernel for SQL Database, and any and all accompanying software, files, data and materials, are 
distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. In 
particular, there is no warranty for the quality of data recovered. You acknowledge that good data 
processing procedure dictates that any program, including Kernel for SQL Database, must be thoroughly 
tested with non-critical data before there is any reliance on it, and you hereby assume the entire risk of all 
use of the copies of Kernel for SQL Database covered by this License. This disclaimer of warranty 
constitutes an essential part of this License. In addition, in no event does LEPIDE SOFTWARE PRIVATE 
LIMITED authorize you or anyone else to use Kernel for SQL Database in applications or systems where 
Kernel for SQL Database failure to perform can reasonably be expected to result in a significant physical 
injury, or in loss of life. Any such use is entirely at your own risk, and you agree to hold LEPIDE 
SOFTWARE PRIVATE LIMITED harmless from any and all claims or losses relating to such unauthorized 
use. 

General 

This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and 
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and 
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises, 
obligations or representations made by LEPIDE SOFTWARE PRIVATE LIMITED herein. 

 Any waiver by LEPIDE SOFTWARE PRIVATE LIMITED of any violation of this License by you shall not 
constitute, nor contribute to, a waiver by LEPIDE SOFTWARE PRIVATE LIMITED of any other or future 
violation of the same provision, or any other provision, of this License. 


